
PVII IMAGE ROTATOR MAGIC 

 

Image Rotator Magic is a powerful, feature-rich Dreamweaver Extension that enables you to 

instantly create and manage one or more image/banner rotators on your page with the efficiency 

of standards-based CSS and markup—and without the overhead of Flash or the difficulties of open 

source script libraries. 

We hope you enjoy using this product as much as we did making it. 

Al Sparber & Gerry Jacobsen PVII 
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INSTALLATION 

Look for the extension installer file p7_IRM_115.mxp (or higher) in the root of the zip archive you 

downloaded. Double-click the file to install the extension. Dreamweaver's Extension Manager will 

open and you will be prompted to complete the installation. Once the installation is complete, 

restart Dreamweaver. 

OS X users: If, upon double-clicking the installer, Extension Manager does not properly launch, you have a file association issue. To remedy 

the problem locate the installer file from inside a Finder window and double-click it. 

BEFORE YOU BEGIN 

WORK IN A DEFINED DREAMWEAVER WEB SITE 

Before you begin, make sure you are working inside a defined Dreamweaver web site. This is 

necessary so that Dreamweaver knows how to link required assets. If you are new to Dreamweaver 

or need to learn how to define a web site, please see this tutorial: Defining a Dreamweaver Web 

Site. 

  

http://www.projectseven.com/products/menusystems/pmm/user_guide/getting_started/before_define.htm
http://www.projectseven.com/products/menusystems/pmm/user_guide/getting_started/before_define.htm
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OVERVIEW 

IRM installs into Dreamweaver, giving you a fully automated graphical user interface from which 

you can create and manage Image Rotator widgets. You can add multiple widgets to a page and 

each one can contain as many images as you need. Each widget can have its own styling or widgets 

can share the same styles—the choice is yours. 

Create or Modify: The user interface is designed to open to the correct mode, Create or Modify, 

based on your current insertion point in the document: 

If your insertion point is not within an existing Image Rotator widget the user interface will open in 

Create mode.  

If your insertion point is inside an existing Image Rotator widget the interface will open in Modify 

mode and allow you to make further changes to the existing Image Rotator. 

User Definable Control Configuration -The Image Rotator system includes support for 3 different 

types of control sets, or no controls at all. The user interface allows you to choose which control 

sets will be used and whether to position them above or below the image. The control sets can be 

added in any combination. These are the available sets: 

 No User Controls 

 Paginator Boxes 

 Paginator Overlay Boxes 

 Button Control Bar 

Auto Width and Auto Height Support - By default, an IRM Widget automatically adapts to the 

width of the page element into which you insert it—but can also be set to a fixed width by assigning 

a width in the CSS Style sheet. By default, an IRM Widget automatically adapts to the height of each 

image—but you can also set a fixed height in your widget's CSS if necessary. 
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Dreamweaver Template Support: The system is 100% Dreamweaver Template compatible. You can 

insert one or more widgets into a template (.dwt) page at any time. You can also insert one or more 

widgets into a template-based page. The system will automatically detect the template and adjust 

to allow insertion into an editable region.  

External Linking and Bookmark Support: An opener detection system is included that allows you to 

set up links with special parameters that will load a page and also trigger a specific image in an IRM 

widget on that page. The opener will look for the IRM widget number, an underscore, and the IRM 

image number. There are 2 methods available: 

1. Anchor Method: The system will look for "#irm" plus an image reference after the anchor. 

The anchor, index.htm#irm1_4, will trigger image 4 in the first IRM Widget on the page.  

2. URL Parameter Method: The system will look for "irm=" in the URL parameter. A URL 

parameter, index.htm?irm=2_4, will trigger image 4 in the second IRM Widget on the 

page. You can then give out the link so people can go directly to your specific image. 

Included Dreamweaver Control Behavior: The system also includes a Control Actions Behavior that 

can be used to create Rotator actions on links located anywhere on your page. 

Removal: A handy Remove Image Rotator command is included that can be used to quickly and 

thoroughly remove any Rotator widget from your page. 

Insertion 

Image Rotator Magic widgets can be inserted anywhere on your page. Once you have established 

your insertion point, click the Image Rotator icon  to open the interface. Alternatively, you can 

choose Insert > Studio VII > Image Rotator Magic by PVII. The Image Rotator width will adapt to its 

location. You can insert as many individual Image Rotator widgets as you like on your page. Each 

one can be configured independently to set different options and features. Image Rotator widgets 

on a single page can share the same style theme or be set to separate style themes. Each widget 

can contain any type of content. Content images are directly editable in Dreamweaver Design View 

using normal Dreamweaver editing techniques.  
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INSERTING A NEW IMAGE ROTATOR  

-Establish the insertion point for your new Image Rotator widget by clicking in the area of the page 

where you would like the widget to be created.  

-Click the Image Rotator Magic icon  in the Common Section of Dreamweaver's Insert Bar or 

choose Insert > Studio VII > Image Rotator Magic by PVII. 

Classic Dreamweaver Insert Bar 

 

Dreamweaver CS4 Insert Bar 

 

Dreamweaver CS4 Users: We highly recommend switching to Classic Workspace mode, which allows for a conventional Insert Bar across the 

top of your Design View window. If you use the new CS4 workspaces, the Insert Bar becomes a vertical bar that is somewhat hard to use as it 

lacks support for mouse wheel and keyboard scrolling. 
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The Image Rotator Magic user interface will open in the Create New Image Rotator mode.  

 

You can create more than one Image Rotator widget on your page. Add as many as you like. 

Tip: When you insert an image Rotator, all content will be visible and fully expanded in Dreamweaver to make adding and editing content a 

simple task. The Image Rotator functionality can be tested by previewing in your browser. 
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ASSET FOLDERS 

When you create an Image Rotator Magic widget, the system creates an assets folder named p7irm 

at the same level as the page that contains your widget. This folder will contain a JavaScript file, 

relevant CSS file (or files), as well as an img sub-folder that contains the background images used by 

the CSS. A Fireworks folder will also be created and will contain editable versions of all necessary 

background images. The Fireworks folder does not need to be uploaded to your Web server.   

 

When you publish your site, make sure you upload the entire p7irm folder.  
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MODIFYING AN EXISTING IMAGE ROTATOR 

You can modify any of the existing Image Rotator widgets on your page at any time. 

-Click inside the Image Rotator widget that you wish to modify. 

-Click the Image Rotator Magic icon  in the Common Section of Dreamweaver's Insert Bar or 

choose Modify > Studio VII > Modify Image Rotator Magic by PVII 

Note: If you use a Macintosh computer, Apple bugs will sometimes cause the Modify menu to be inactive (grayed out). If this happens to you, 

use the icon to launch the interface. You can also launch the interface from the Insert menu. If you'd like to fix this Mac bug, download and 

install this Command and then restart Dreamweaver. 

The Image Rotator Magic User Interface will open in the Modify Existing Image Rotator mode. 

 

  

http://www.projectseven.com/go/returnfalsefix
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MANAGING THE USER INTERFACE ITEMS 

MODE 

Displays the current operational Mode for the user interface: either Create or Modify. When in 

Modify mode, the id of the Image Rotator widget being modified will also be displayed. 

IMAGES 

This box displays the image file name for each image in the Image Rotator, one line for each image. 

A newly created line which does not yet have an image assigned will display the default text: "New 

Image". Select (click) the line you wish to act on. 

Add 

Click the Add button to add a new image. A new line will be created with the default text "New 

Image". The new line will be created immediately after the currently selected line. Click the Image 

path Browse button to assign an actual image. 

Delete 

Click the Delete button to remove the currently selected line. The image will be removed.  

Up  

The Up button will move the selected line in the Images list up one row. Successive clicks will keep 

moving the line up, one row per click, until the line is at the top of the list.  

Down 

The Down button will move the selected line in the Images list down one row. Successive clicks will 

keep moving the line down, one row per click, until the line is at the bottom of the list.  

Image Preview 

The Preview box will show a thumbnail version of the image that is currently selected in the Images 

list. 

IMAGE PATH / BROWSE... 

Enter the path to your image, or use the Browse button to open the Select the Rotator Image 

dialog box. You can change the image at any time by selecting the image in the Images list and 

clicking the "Browse..." button. Valid image types are: .gif, .jpg, and .png.  
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IMAGE ALT TEXT 

Enter descriptive text for the related image. 

DESCRIPTION 

 

The Description box allows you to supply additional text that will display at the bottom of the 

image. You can enter normal text or you can enter actual (x)html markup into this box. When 

entering (x)html markup you can create paragraphs, headings, and even links, as shown in the 

screen capture above. Leave this box blank if you do not wish to show any descriptive text to 

appear.  

Note: When entering plain text the system will automatically convert any line breaks to a <br> markup tag so that the line break will be viewable 

in the actual presentation. If the system detects actual markup that you have entered, then it will ignore line breaks. 

IMAGE LINK PATH / BROWSE... 

The Image Link Path box allows you to set a hyperlink on the image. When the image is clicked the 

system will launch the linked page. Click the Browse button to open the Select the File to Link 

dialog box and choose the html page that you wish to link to. The Image Link functionality is 

optional and is blank by default. Supplying a link in this box enables the image link for the currently 

selected image. No other images are affected. 

Link Title 

This box allows you to add a title attribute to the Image Link, which will display as a small pop up 

near the cursor when the user mouses over the image. Enter a short description in plain text. 

Open in New Window 

By default any linked page will open in the current browser window or tab, replacing the current 

page. Check this box if you want the linked page to open in a new browser window or tab.  

Target 

If you are using the Image Rotator on a frames-based page, or would like the linked page to open in 

an iframe then enter the name of the Frame that you want the linked page to load into in this box. 
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OPTIONS 

These settings are applied to the current Image Rotator widget. Other Image Rotator components 

on the same page can have different Options.  

CONTROLS 

The user interface allows you to choose which control sets will be used and also allows a choice of 

position, above or below the image. You can choose to use one control set, no control sets, all 

control sets, or any combination. 

Paginator 

The Paginator Bar will create a series of boxes, one for each image, in a horizontally oriented list. 

These will act as trigger links to display the associated image. Choose the display option from the 

drop down list.  

Pause/Play 

You can choose to have a fully functional text-based Pause/Play link displayed at the end of the 

Paginator Bar by checking the Pause/Play box. 

Paginator Position 

Choose how you would like the Paginator Bar displayed: 

 Above Image 

 Below Image 

 Overlay Top 

 Overlay Bottom 

Toolbar 

The Toolbar is an image-based control set that features First, Previous, Pause/Play, Next, and Last 

buttons. 

Toolbar Position 

Choose how you would like the Toolbar displayed: 

 Above Image 

 Below Image 
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PAGE LOAD 

You can choose the Image Rotator startup configuration when the page first loads into the browser.  

Start With Image 

Enter the number of the image which you would like as the current image when the page first 

loads. 

Start With Random Image 

Select this option if you wish to have the system randomly select an image to open. Each time the 

page loads into the browser a random image will be selected. 

ROTATOR MODE 

IRM rotates images in succession, starting with the currently active image. 

Choose one of these Rotator Modes: 

 Auto Reverse -With the Auto Reverse option enabled, when the last image is reached, the 

system will switch to the previous image and continue playing in reverse order until it 

reaches the first image. Then it will reverse again, advancing to the last image—and so on. 

 Loop Back to First Image -The Rotator will display each image in successive order from first to 

last. When the last image has been displayed it will switch back to the first image and 

continue playing through the image list. 

Show Image for 

This controls the amount of time each image is displayed during the rotation, in milliseconds. The 

default is 5000ms (5 seconds). To display each image for 8 seconds, for example, enter 8000 into 

the box. 

STARTUP 

Play on Startup 

Check this box if you want to have the image rotator start automatically when the page first loads. 

Tip: If you have opted to not have any controls or a toolbar then do make sure that Play on Startup is selected. 
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Show Initial Image For 

This controls the amount of time the first image is displayed. During page load it is often desirable 

to allow the first image to be displayed slightly longer than the other images to give the rest of the 

page assets a chance to load. The default is 8000ms (8 seconds). For example, to display the first 

image for 12 seconds enter 12000 into the box. 

Description Closed 

The Description box includes a Close or Open control icon which allows the user to close or open 

the Description box at any time. By default the Description is shown in the open state when the 

page first loads. If you want the Description to start in its closed state then check this box. 

NUMBER OF ROTATIONS 

Enter the number of times you wish the Rotator to play through all of the images. By default this 

box is disabled and the No Limit -Play Continually option is turned on. To activate this box 

uncheck the No Limit -Play Continually option and enter a number in the box. 

No Limit -Play Continually 

This option allows the Rotator to play through the images indefinitely. It will not stop unless the 

user clicks the pause button (if you've made it available). 

End Rotation On 

This allows you to choose the ending image for the Rotator. If you've set a number of rotations, 

when the Rotator has completed the assigned number of rotations it will stop on: 

 Last Image -The Rotator will stop at the last image in the Image list. 

 First Image - When the Rotator reaches the last image it will loop back and stop at the first 

image in the Image list. 

ANIMATION 

You can select one of 2 different animation options: 

 0-None -Choose this option to disable animation. 

 1-Fade -This provides a smooth cross-fade from one image to the next.  
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Duration 

This option allows you to control the cross-fade speed. Duration defines the total amount of time 

that the animation will run, in milliseconds, regardless of the image size. The default 1500 (one and 

a half seconds) is fine in most cases. Lower the Duration setting and the animation will be faster. 

Raise the setting to make the animation slower. 

MOUSE ACTIONS 

Pause on Mouse Over 

Select the Pause on Mouse Over option if you want the Rotator to pause when the user's mouse is 

over the image. The Rotator will automatically resume once the mouse is moved away from the 

image.  

Disable Right-Click on Rotator 

The Disable Right-Click on Rotator option suppresses the browser's right-click context menu when 

the user right-clicks the image. This option simply impedes casual users from easily copying or 

dragging the image. The browser context menu is only suppressed for the image and will continue 

to work normally on all other parts of the page. 

Note: Disabling the right-click is not a failsafe copyright protection method. There is no way to prevent savvy users from copying your images—

even if you use Flash. By suppressing right-click we are helping you to prevent users with a low level of computer proficiency from easily 

copying your images. 

STYLE THEME 

Image Rotator Magic includes 2 style themes: Light Toolbar and Dark Toolbar. 

A preview of the selected Style Theme's optional toolbar is displayed to the right of the Style 

Theme select list. This Preview will change whenever you select a different Style Theme. 

Note: In an image or banner rotator, the images are the star of the show. The style themes provided are purposely neutral to ensure that 

nothing competes with your images for attention. The p7irm/img folder contains several extra background images that can be used for your 

optional Description Popup. You can assign the image to the .p7IRM01 .p7IRMdesc or .p7IRM01 .p7IRMdesc CSS classes in your IRM style 

sheet. See the User Guide for additional details. 
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THE INTERFACE CONTROL BUTTONS 

OK 

When you are done, click the OK button to build the Image Rotator. The system will verify your 

selections and alert you to any problems that need your attention. If there are no problems, the 

interface will close and an Image Rotator will be added to your page or updated—depending on 

whether you were in Create mode or Modify mode. You can then preview in a browser to 

operate the Image Rotator and check its functionality. 

Cancel 

Click the Cancel button to completely abort the current operation. This will close the interface and 

no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. The Help File can remain 

open for easy reference while you continue working with the Image Rotator Magic interface. 
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REMOVING A ROTATOR FROM YOUR PAGE 

The Image Rotator system includes a Remove command that allows you to quickly remove an 

existing Image Rotator widget from your page. 

OPEN THE REMOVE PVII IMAGE ROTATOR INTERFACE 

-Open a page that contains one or more Image Rotator widgets. 

-Choose Commands > Studio VII > Remove Image Rotator... to open the Remove interface.  

 

Note: The Remove option will be unavailable (grayed out) if there is no Image Rotator widget on the page. If you do have a widget on your page 

and the Command option is still grayed out, then you have a Mac with a Mac bug that causes menu entries to be inactive (grayed out). If this 

happens to you, download and install this Command and then restart Dreamweaver. 

The Remove Image Rotator interface will open. 

 

The interface will provide a listing of all of the Image Rotator widgets on your page. The list will 

display the root ID of each widget.  

-Select the widget that you wish to remove from the listing (you can only remove one widget at a 

time). 

Tip: If you are unsure about which widget relates to which ID, click the Cancel button and switch to Code View. In Code View, locate all IDs that 

begin with p7IRM. The opening DIV tag looks like this:  

<div id="p7IRM_1" class="p7IRM01"> 

  

http://www.projectseven.com/go/returnfalsefix
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WHAT WILL BE REMOVED  
The system will completely remove the html markup for the selected widget from your page. If 

there are other Image Rotator widgets on the page they will not be affected. The system will also 

remove the link to the relevant CSS file if no other widget on the page is using the same style 

theme. 

If there are no remaining Image Rotator widgets on your page, the system will also remove the link 

to the Image Rotator JavaScript file. 

WHAT WILL NOT BE REMOVED 

The system will not remove the p7irm folder, which contains the widget-related assets (images, 

JavaScript file, and CSS files). This ensures that you will not lose any assets you may have modified 

and any other pages that depend on those modified assets will continue to look and behave as 

expected. 

THE INTERFACE CONTROL BUTTONS 

REMOVE 

Click the Remove button. The selected Image Rotator widget will be removed from the page 

CANCEL 

Click the Cancel button to completely abort the current Remove Image Rotator operation. This will 

close the interface and no changes will be made to your page. 

HELP 

Click the Help button to open the associated Help File in your browser. This page can remain open 

for easy reference while you continue working with the Image Rotator interface. 

  



 

20 The Image Rotator Magic Behavior | PVII Image Rotator Magic 

 

20 The Image Rotator Magic Behavior 

THE IMAGE ROTATOR MAGIC BEHAVIOR 

The Control Actions Behavior allows you to configure a link anywhere on your page to remotely 

operate any Image Rotator widget on your page.  

Available Control Behavior Actions: 

 Open First Image 

 Open Previous Image 

 Play (Resume) Rotator 

 Pause Rotator 

 Open Next Image 

 Open Last Image 

 Open Image Number ... 

CREATING A NEW CONTROL ACTIONS BEHAVIOR 
1. Select (click) a text link or image to act as the behavior Control.  

2. Open your Dreamweaver Behaviors Panel (Shift + F4)  

3. Click the plus sign (+) on the Behavior Panel.  

4. Choose Studio VII > Image Rotator > Control Actions to open the interface.  

5. Select the widget you wish to act on.  

6. Select the action.  

7. Click OK to apply the behavior.  

MODIFYING AN EXISTING CONTROL ACTIONS BEHAVIOR 
1. Select the element that contains an existing Image Rotator Control behavior.  

2. Double-click the Image Rotator Magic- Control Actions behavior in the Behaviors Panel to 

open the interface.  

3. Select the widget you wish to act on.  

4. Select the action.  

5. Click OK to apply the revised behavior.  
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THE INTERFACE 

The Image Rotator Magic -Control Actions interface allows you to select an action to apply. 

 

THE INTERFACE ITEMS 

Image Rotator 

The interface contains a listing of all of the Image Rotator widgets on your page. The list will display 

the ID of each widget. Select the Image Rotator you want to control.  

Tip: If you are unsure about which widget relates to which ID, click the Cancel button and switch to Code View. In Code View, locate all IDs that 

begin with p7IRM. The opening DIV tag looks like this:  

<div id="p7IRM_1" class="p7IRM01"> 

Action 

Select the action you want to apply.  

 

First Image 

This will display the First image.  
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Previous Image 

This will display the image that comes before the currently displayed image. 

Play 

This will Start or (resume) the Auto Play Mode. 

Pause 

This will Stop (or pause) the running Auto Play mode. 

Next Image 

This will display the image that comes after the currently displayed image. 

Last Image 

This will display the last image. 

Open Image Number... 

This allows you to select the exact image to be displayed by entering the Image Number. 

Image Number 

This box is active only when the Open Image Number action is selected. Enter the number of the 

image you wish to display. 
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THE INTERFACE CONTROL BUTTONS 

OK 

When you have made your selection, click the OK button to apply the behavior. By default the 

behavior will be applied to the onClick event of the text link or image. You can change the event by 

selecting the desired event in the Behaviors panel.  

Cancel 

Click the Cancel button to completely abort the current operation. This will close the interface and 

no changes will be made to your page. 

Help 

Click the Help button to open the associated Help File in your browser. This page can remain open 

for easy reference while you continue working with the Image Rotator Magic interface. 
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QUESTIONS AND ANSWERS 

The following questions and answers should prove helpful as you build and manage your widgets. 

HOW DO I USE OR MANAGE WIDGETS IN DIFFERENT FOLDERS? 

When you create a widget, the system writes a folder named p7irm in the folder that contains the 

page you are working on - and uses that folder to store style sheets, images, and scripts. This allows 

for easy and safe prototyping. If you create a widget on page1.htm, in a folder named tutorials, and 

edit the CSS for that widget, your changes are restricted to that folder. Make another page in that 

folder and create a widget using the same Style Theme and it will use the same style sheet you 

edited while working on page1. If you create a widget on a page in a new folder, the system will 

create a new p7irm folder inside that folder and populate it with default style sheets, scripts, and 

images. This allows you to test and prototype with complete freedom - without affecting finalized 

pages in other folders. 

There may, however, be times when you want widgets in different folders to use the same style 

sheets. To do that, create your widgets first. Then decide which p7irm assets folder you want to use 

for all your pages. You'll need to set the paths for all CSS files, and the JavaScript file, to point to the 

p7irm assets folder you want to use. For a page with a widget using the Dark Toolbar theme, the 

CSS and script links look like this: 

<link href="p7irm/p7IRM01.css" rel="stylesheet" type="text/css" media="all" /> 

<script type="text/javascript" src="p7irm/p7IRMscripts.js"></script> 

You can change the path to CSS or script files visually in Dreamweaver by displaying Head Content 

in a toolbar at the top of your design window. To turn this feature on, choose View > Head 

Content. 

Click the appropriate icon and your Property Inspector will change to reflect your choice, easily 

enabling you to browse to the location of the assets folder you want to use. 
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CAN I REVERT BACK TO A DEFAULT STYLE THEME CSS FILE? 

Should you ever make a large error and need to revert back to a default and working CSS file, do 

this:  

1. Delete the bad CSS file from your p7irm folder 

2. Open a page in that folder that contains a widget that uses that bad style sheet. Your 

widget may appear unstyled. Don't worry, that's expected, given the circumstances 

3. Place your cursor inside the widget 

4. Open the IRM UI in Modify Mode 

5. Make no changes in the UI - simply click the OK button 

6. The system will create a new version of the appropriate CSS file 

Depending on your DW version, you might not see the changes at first. If that be the case, save and 

close the file, then re-open it. 

MY FONT STYLES/COLORS ARE NOT SHOWING UP, WHAT DO I DO?  

Chances are there are rules in other style sheets attached to your page. If, for example, your widget 

was inserted into a DIV that has an ID of maincontent and a corresponding CSS rule, and that rule 

contains competing font properties, you will need to make your widget's CSS rule more specific. 

You do that by adding the ID of the element your widget is inside of to the beginning of the IRM 

rule. For instance, if you have a rule in your page style sheet that sets font color for links, such as: 

#maincontent a { 

color: #FF0; 

} 

If that rule causes all links in your Rotator to be #FF0, then you can change the selector name(s) of 

the affected rules in your IRM style sheet to be prefaced with #maincontent: 

#maincontent .p7IRM01 .p7IRMdesc a { 

color: #69C; 

} 

You can also just add an !important notation to the IRM rule: 

.p7IRM01 .p7IRMdesc a { 

color: #69C !important; 

} 
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MY IMAGES ARE TOO WIDE AND POUR OVER THE EDGE OF MY CONTAINER IN DREAMWEAVER.  

IS THERE A FIX FOR THIS? 

IRM is designed to automatically adjust to the width of your layout. If you insert a widget inside a 

layout container that is 600 pixels wide, and your images are 640 pixels wide, the excess 40 pixels 

will be cropped. CSS bugs in Dreamweaver CS4 (and under) will, however, display the full width of 

the image—the same problem that you'll see in Internet Explorer 6 and under. The same 

workaround that fixes IE6 will also fix Dreamweaver Design View. Here is the fix: 

Locate this rule in your IRM style sheet: 

.p7IRM01 .p7IRMdv { 

padding: 0px; 

border: 0; 

position: relative; 

margin: 0; 

overflow: hidden; 

} 

The selector name will begin with either .p7IRM01 or .p7IRM02 depending on the style theme you 

are using. 

Assign a width equal to the width of your layout container. If your container is 600 pixels wide 

make the width of .p7IRM01 .p7IRMdv 600px: 

.p7IRM01 .p7IRMdv { 

padding: 0px; 

border: 0; 

position: relative; 

margin: 0; 

overflow: hidden; 

width: 600px;  

} 

Depending on the complexity of your CSS layout, you might need to adjust the width slightly, based 

on the CSS box model. Simply change the width value until it appears just right in Dreamweaver and 

IE6. 
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SOME OF MY IMAGES ARE DIFFERENT HEIGHTS.  

MUST I EDIT MY IMAGES OR IS THERE A CSS TWEAK I CAN USE? 

IRM is an image/banner rotator and as such works best when all images are the same height. If one 

or more images are different, the widget will display the image, but the transition will be abrupt 

and any content below your widget will move up or down with the image. If you do not want to 

resize your images in an image editor, you can assign a height to the IRM image container. This will 

cause the browser to crop the image to the height you set. 

Locate this rule in your IRM style sheet: 

.p7IRM01 .p7IRMdv { 

padding:0px; 

border: 0; 

position: relative; 

margin: 0; 

overflow: hidden; 

} 

The selector name will begin with either .p7IRM01 or .p7IRM02 depending on the style theme you 

are using. 

Assign a height. It is usually best to set the height based on the shortest image in your set. If the 

shortest image in your set is 140 pixels high, set the height to 140px: 

.p7IRM01 .p7IRMdv { 

padding: 0px; 

border: 0; 

position: relative; 

margin: 0; 

overflow: hidden; 

height: 140px;  

} 
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IS THERE ANY WAY TO MOVE THE DESCRIPTION TO THE TOP OF MY IMAGES AND HAVE IT DROP 

DOWN? 

Yes. That requires a relatively simple CSS tweak. Locate this rule in your IRM style sheet: 

.p7IRM01 .p7IRMdesc_wrapper { 

position: absolute; 

width: 100%; 

bottom: 0px; 

visibility: hidden; 

overflow: hidden; 

} 

The selector name will begin with either .p7IRM01 or .p7IRM02 depending on the style theme you 

are using. 

Change bottom to auto. Then add a top property and set it to 0: 

.p7IRM01 .p7IRMdesc_wrapper { 

position: absolute; 

width: 100%; 

bottom: auto; 

top: 0;  

visibility: hidden; 

overflow: hidden; 

} 
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Now locate this rule: 

.p7IRM01 .p7IRMdesc_open_wrapper { 

overflow: hidden; 

position: absolute; 

z-index: 20; 

padding: 0; 

margin: 0; 

bottom: 0px; 

visibility: hidden; 

right: 0px; 

height: 30px; 

width: 30px; 

} 

Change bottom to auto. Then add a top property and set it to 0: 

.p7IRM01 .p7IRMdesc_open_wrapper { 

overflow: hidden; 

position: absolute; 

z-index: 20; 

padding: 0; 

margin: 0; 

bottom: auto; 

top: 0; 

visibility: hidden; 

right: 0px; 

height: 30px; 

width: 30px; 

} 
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CAN I EDIT THE TEXT AND LINK COLORS OF MY IMAGE DESCRIPTIONS? 

Yes. This is the rule that control the Description text: 

.p7IRM01 .p7IRMdesc { 

color:#CCC; 

background-image: url(img/p7IRMDark_transblack.png); 

font-family: Arial, Helvetica, sans-serif; 

font-size: 10px; 

padding: 12px 36px 12px 24px; 

margin: 0; 

} 

And these are the style rules for links inside your image Descriptions: 

.p7IRM01 .p7IRMdesc a { 

color: #69C; 

} 

.p7IRM01 .p7IRMdesc a:hover { 

color: #FFF; 

} 
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CAN I EDIT THE TOOLBAR BUTTON IMAGES OR THE DESCRIPTION BACKGROUNDS? 

When you create an IRM widget, the system will create a Fireworks folder at the same level as your 

page and in that folder will be Fireworks documents for each style theme. Use these documents to 

edit the background images for a theme. These are the Fireworks documents: 

 p7IRM_Dark.png 

 p7IRM_Light.png 

 p7IRM_Extra_Desc_BGs.png 

It is highly recommended that unless you are proficient with both image editing and CSS that you limit your edits to simple color changes. 

Once you've edited the images inside a Fireworks document, you need to export the images back to 

your Web site's p7irm/img folder. In Fireworks, use these export settings: 

 

Note: The File name box is irrelevant since you are exporting slices. 
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CAN I CHANGE THE TRANSPARENT BACKGROUND OF MY DESCRIPTION TO ANOTHER COLOR? 

Yes. The p7irm/img folder contains several alternatively colored images you can use. They are: 

 p7IRM_transblue.png 

 p7IRM_transgreen.png 

 p7IRM_transpurple.png 

 p7IRM_transred.png 

 p7IRM_transteal.png 

 p7IRM_transyellow.png 

Edit the .p7IRM01 .p7IRMdesc rule to point to one of the above images: 

.p7IRM01 .p7IRMdesc { 

color:#CCC; 

background-image: url(img/p7IRM_transyellow.png); 

font-family: Arial, Helvetica, sans-serif; 

font-size: 10px; 

padding: 12px 36px 12px 24px; 

margin: 0; 

} 

IS THERE A PLACE ON THE PVII SITE WHERE I CAN FIND MORE EXAMPLES, TUTORIALS, OR 

TWEAKS? 

Yes. Go to the IRM Home Page. All new content will be linked from there. 

  

http://www.projectseven.com/products/galleries/irm/
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SUPPORT AND CONTACT INFO 

PVII quality does not end with your purchase - it continues with the best customer support in the 

business. 

PVII KNOWLEDGE BASE  

The PVII Knowledge Base is an online PVII application allowing you to access dozens of Tech Notes, 

tips, and techniques relating to our products, as well as to general web development issues. 

Open the Knowledge Base | View the 10 Most Recent Additions 

NEWSGROUP FORUM COMMUNITIES 

The Project VII Newsgroup community is our primary support vehicle and is available 24 hours a 

day. Choose from the following newsgroups:  

1. The PVII Webdev Newsgroup 

2. The PVII Dreamweaver Newsgroup 

3. The PVII Fireworks Newsgroup 

4. The PVII CSS Newsgroup 

Note: If you have trouble linking directly to news servers, use your default newsreader's program options to set up a new account and point it at 

the following server: 

forums.projectseven.com 

Setting up a new newsgroup account in Outlook Express 

Setting up a new newsgroup account in Mozilla Thunderbird  

Setting up a new newsgroup account in Entourage  

If you have another newsgroup-capable program that you are using, please see its documentation 

to learn how to add a new newsgroup account. 

Note: PVII newsgroups are private and have nothing to do with UseNet feeds that may be provided by your ISP. That is, you will not find our 

newsgroups in a list of newsgroups distributed by your internet service provider. You must set up our news server as a new account.  

  

http://www.projectseven.com/support/questions.asp?type=cat1&id=440
http://www.projectseven.com/support/questions.asp?type=recent
news://forums.projectseven.com/pviiwebdev
news://forums.projectseven.com/dreamweaver
news://forums.projectseven.com/fireworks
news://forums.projectseven.com/css
http://www.projectseven.com/support/oe.htm
http://www.projectseven.com/support/tbird.htm
http://www.projectseven.com/support/entourage.htm
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RSS NEWS FEEDS 

Keep up with the latest news the minute it's released by subscribing to our RSS news feed. If you 

are not sure how to subscribe, please check this page: 

PVII RSS Info 

BEFORE YOU CONTACT US 

Before making a support inquiry, please be certain to have read the documentation that came with 

your product. Please include your Dreamweaver version, as well as your computer operating 

system type in all support correspondence. 

E-Mail: 

support@projectseven.com 

Phones:  

330-650-3675 

336-374-4611 

Phone hours are 9:00am - 5:00pm Eastern Time U.S. 

SNAIL MAIL 

Project Seven Development 

339 Cristi Lane  

Dobson, NC 27017 

  

  

http://www.projectseven.com/xml/index.htm
mailto:support@projectseven.com
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